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OpenRoads Designer: 
Cross-Section Sheets 

 

Cross-Section Sheet Process Overview 

The process to generate cross-section sheets is very similar to the plan and profile sheet process. 

OpenRoads designer uses MicroStation Named Boundaries to define the cross section clipping areas. The 
named boundaries are placed in a 3D Design model relative to a selected alignment. 

The example below shows the 3D Named Boundaries placed relative to the St. Peter Road 3D model. 

Before generating the named boundaries, a design file is created as a “container file” to attach references 
and place the named boundaries for the cross-section locations. The 3D model must be displayed in order 
to place the named boundaries. The cross section are cut from the 3D model. In the example above, the 
geometry, survey, and corridor model basemaps are attached to the plan view with the 3D model displayed. 
The named boundaries are placed in the 3D model relative to a selected alignment.  

When the sheets are generated, the software creates a MicroStation drawing model for each named 
boundary. An example of the drawing model for a cross-section is shown below. 
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The drawing models are referenced to a sheet model with a sheet border to assemble the completed cross-
section as shown in the example below. 

 
 
The sheet model is intended for plotting or PDF generation. Most annotations should be placed in the 
various drawing models, not in the sheet models. 
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File Types and Usage 
A “container file” is used to attach references for the information that will be shown in the cross sections as 
well as to place the named boundaries for the cross-section locations. 

Sheets can be clipped into the container file itself, or clipped into multiple files, one sheet per design file, if 
desired. 

Each container file is used to generate the sheets for a single alignment. For example, a project with three 
alignments would typically use three container files as detailed below: 

Design File Usage Models Used 
XS000 Container file for S.R. 185 Design 
XS001, XS002, XS003… Cross-section sheets for S.R. 185 Drawing and Sheet 
 
XS100 Container file for St. Peter Road Design 
XS101, XS102, XS103… Cross-section sheets for St. Peter Road Drawing and Sheet 
 
XS200 Container file for Jameson Road Design 
XS201, XS202, XS203… Cross-section sheets for Jameson Road Drawing and Sheet 

 
The references are attached as illustrated below. 
 

 
 
The container file is used to control the reference attachment and level display settings for all the sheets 
from one location. More information on level display can be found in the Level Management section of this 
document. 

It is possible to put the named boundaries for multiple alignments in one container file if all the sheets will 
share the same reference attachments and level display settings.  

Basemap Files
The various basemap 
design files (survey, 

alignments, drainage, 
etc.) are used to draw 

the existing and 
proposed information 

for the project.

Container File
The container file's 

design model is used 
to attach the various 
basemap design files 
as references, and to 

place the named 
boundaries for the 

cross-sections.

Sheet File
The drawing models in 

the sheet file 
references the 

container file's design 
model. The drawing 
models are used for 
sheet annotation.

The sheet model self-
references the sheet 
design file's drawing 
models. The sheet 

models are used for 
the sheet border and 

for plotting.
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End Area Volumes 
End areas can be extracted from the 3D model for each named boundary and included on the completed 
sheets. This process requires 3D mesh elements for the cut and fill areas. The 3D mesh elements should be 
created in a separate design file. These 3D meshes are normally created before starting the sheet clipping 
process. 
 
 

Cross-Section Sheet Summary 
The steps to generate cross-section sheets are summarized below: 

1. If end area quantities are to be displayed, create a design file to contain the 3D mesh elements and 
run the Create Cut Fill Volumes command 

2. Create a design file to act as the container file 
3. In the container file, take the following steps to prepare for clipping the cross-section sheets: 

a. Attach the various design files containing the 3D models and survey information, 
underground utilities, 3D right-of-way lines, etc. that will be shown on the cross-sections. 
Also attach the design file containing the 3D mesh volume elements 

b. Assign the existing ground terrain model as the active terrain 
c. Open a 3D view of the model 
d. Toggle on/off the Global Display of the levels in the Design-3D model that you wish to be 

displayed in the cross-sections. 
e. Create Named Boundaries for the cross-section locations, but do not create the sheets yet. 
f. If end area quantities are to be displayed, run the End Area Volume report. Each named 

boundary is tagged with the quantity values 
4. Create the cross-section sheets. The sheets can be generated into the active design file (the 

container file) or into separate design files. 

  



 
Ohio Department of Transportation 
Office of CADD and Mapping Services May, 2024 

 

802 Cross-Section Sheets 802-5 
 

Create Cut and Fill 3D Meshes 

The Create Cut Fill Volumes command is used to generate 3D mesh elements for the cut and fill volumes. 
These elements are required to generate end area volumes for the cross-section sheets. This training guide 
will document the process to create simple cut/fill quantities. 
 
An example of the 3D mesh elements is shown below. 
 

 
 
 
The 3D mesh elements are generated in the Roadway Digital Terrain Model file type. 
 
When using the OHDOT Create Design Files application the Seed option will default to the DesignSeed3d 
file. Change this to the DesignSeed2d option as shown below. 
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After the file is created, the next step is to attach the design files as a reference that contain the existing 
ground terrain and the proposed corridor models. 
 
The Create Cut Fill Volumes process will compare the lowest proposed component to the active terrain to 
generate 3D prismoid volumes. Be sure to set the existing ground terrain as the active terrain before 
running the command. The command is accessed by selecting OpenRoads Modeling > Home > Civil 
Analysis > Create Cut Fill Volumes. 

 
 

The tool settings for the command are shown at left. 
 
Accept each option by issuing a left click as each option is 
presented on the cursor. 
 
The 3D mesh elements for the cut and fill volumes are placed in 
the 3D model like the example shown on the previous page. 
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Creating the Container File 

Design files are created using the OHDOT Create Files application. The application is accessed from the 
Ohio DOT WorkFlow by selecting the New Design File icon. 

The application is opened as shown below. 

 

In the example above, the file suffix of 000 has been entered for the Cross Sections sheet type. The 
application recognizes the 000, 100, 200, etc. series as container files and has automatically switched the 
Seed file to the appropriate design seed for the WorkSet. 
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Reference Attachments 
After creating the new design file for the cross section named boundaries, attach the references necessary 
to generate the cross sections. 

As a minimum, the following files will need to be attached: 

• Survey basemap containing the existing ground terrain model. 
o Note: Be sure to set the existing ground as the active terrain after the file is attached. This 

will create a 3D model in the active cross section sheet design file 
• Geometry basemap containing the alignments 
• Corridor Modeling basemaps containg the applicable corridors 

Several additional files may be included as attachments depending on the project: 

• Any other files that contain 3D information (utilities, right-of-way, etc.) that is to be displayed on 
the cross sections 

• The design file that contains the prismoidal volume areas, which is required to display end-area 
quantities on the sheets 

After the references are attached, it is necessary to configure the view windows to display both plan and 3D 
model information. Hold down the right mouse-button with the cursor positioned in a MicroStation view 
window until the pop-up menu appears. Select the 2 Views Plan/3D option as shown below. 

 

The graphics that will be displayed on the clipped cross sections are controlled by what is displayed in the 
3D view. Toggle on/off the desired levels in the 3D view before proceeding. 
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Named Boundaries 
Sheets are clipped using Named Boundary tool. From the OpenRoads Modeling workflow, select the 
Drawing Production tab to access the Named Boundary tool as shown below. 

Note: The Named Boundary tool can also be accessed from most of the default workflows provided within 
ORD. 

The Place Named Boundary Civil Plan dialog is opened as shown below. 

 

The top of the dialog contains several icons to 
select the type of named boundary that you wish to 
place.  

The following icons will be discussed in this 
document: 

  Civil Cross Section 

  Civil Cross Section 2 Points 

 

 

 

 

 

 

Note: Toggle the Create Drawing option off if generating end area volume quantities to be displayed on 
the cross-section sheets. The Named Boundaries must be placed before running the End Area Volumes 
Report. See End Area Volume Report for more information. 

Select the fourth icon, Civil Cross Section to begin the process of placing the cross section named 
boundaries. The Drawing Seed item is used to select the configuration for placing cross section named 
boundaries. As of this writing, two options are available to define the named boundaries for cross section 
sheet clipping. 

o Cross Sections 5-Scale 
o Cross Sections 10-Scale 
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Issue a left mouse-click in the Start Location Field. And then select the desired alignment that will be used 
as the centerline for the cross-section clipping. The Start Location value will dynamically change as the 
cursor is moved within the view window. Note that the second Name field will change from “Untitled”, as 
shown above, to the name of the selected alignment. 

• Identify the desired Start Location by issuing a data-point within the view, by keying in a station 
value, or by selecting the icon to the right of the Start Location field to lock the starting location to 
the beginning of the selected alignment. 

After the Start Location has been established, identify the desired Stop Location. As the cursor is moved, 
the Stop Location will track the station value relative to the cursor position. Clipping borders are 
dynamically displayed as the cursor is moved. The stop location can be entered by issuing a right-mouse 
click in the view, keying in the desired station, or by selecting the icon to the right of the Stop Location 
field to lock the ending location to the end of the selected alignment. An example is shown below. 

Create Drawing 
This option is used to initiate the process to create the sheets after the named boundaries are placed.  

• Turn this option OFF if you want to update the named boundaries with the end area quantities 
before generating the sheets. See the End Area Volume Report section. 

• Turn this option ON to generate the sheets without any end area values. The end areas can be 
updated later as detailed below. 
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Placing the Named Boundaries 
After the parameters in the Place Named Boundaries dialog has been defined, it takes two left-mouse 
clicks to initiate the named boundary placement. 

• Issue a left mouse-click to accept the Start and Stop Location values 
• Issue another left mouse-click to accept the named boundary placement. Named boundaries are 

drawn in the 3D view representing the clipping limits for each cross section as shown below 

If the Create Drawing and Show Dialog options 
are toggled on, the Create Drawing dialog, shown 
at left, is opened. 

Toggle in the One Sheet Per DGN option if desired 
and set the path for the new cross-section sheets. 
When this option is selected, the Sheet Model > 
Model Name parameter is used to specify the 
name of the cross-section sheet design files. 

Check to ensure that the Drawing Model 
annotation scale and Sheet Model Detail Scale 
parameters are set properly for the corresponding 
cross-sections. 

Always set the Sheet Model annotation scale 
parameter to 1:1 as shown at left. 

Select OK to initiate the sheet clipping process. 

Open Model 
• Turn this option OFF if you don’t want this 

process to open the last generated sheet. 
• Turn this option ON if you want this process 

to open the last generate sheet. 
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Deleting Named Boundaries 
The Named Boundaries tool as you’ll notice can be found under various workflows. But will always be 
located under either the View tab or Drawing Production tab. For this example, we will be using the 
OpenRoads Modeling workflow. 

 

 

 

Open the Named boundaries Manager by clicking the Open Dialog arrow.  

 

 

 

 

 

The Named Boundary Manager dialog shows all the 
named boundaries that have been placed within the dgn 
file that they were generated.  

To delete these named boundaries right click and 
highlight the boundary then hit the red “X”.   

 

 

 

 

You will then be prompted with a warning 
dialog (shown below). Once you click “yes” the 
named boundary will be deleted from the 
Named Boundaries Manager and the Saved 
View will be deleted from the Saved View 
Manager the dgn.  
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Sheet Clipping Models and Saved Views 
After clicking the OK button within the Create Drawing dialog software creates a drawing model that 
contains the cross-section annotations which is automatically generated. Also, within this process the 
software will create a “snapshot” of the cross sections design-3D model which is considered a Saved View. 
This will be done for each cross-section. 

Cross Section Sheet models  
These consist of  

• Sheet borders.  
• Referenced Cross section drawing models. 
• Sheet totals for seeding, cut, and fill. 

Note: No annotations should be placed within the 
sheet model apart from the listed above. 

 
 

 

 

 

 

The Models dialog (Home > Models) can be used to review each of the newly created model, as shown 
below. The software will attempt to place as many cross-sections as possible on the sheets. 
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Note: The spacing above and below each cross-section, 
within the grid lines, is set in the Place Named Boundary 
dialog by setting the Top Clearance and Bottom 
Clearance values. The default values for the bottom 
clearance have been set to account for the presence of 
underground utilities, however, the value represents a 
default setting and may not be appropriate for all cases.  

 

 

 

 

 

The spacing between the cross sections is set by a configuration variable. 

 

 

 

 

 

 

 

 

 

 

Saved Views 
The Saved Views tools can be accessed under various workflows under the Drawing Production tab. The 
Saved View tab gives you the ability to apply views as well as to create new views that you can recall later. 
Views display as thumbnails sorted alphabetically. You can filter the list by using the search bar or change 
from thumbnails to a list by selecting the list display icon. 
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Saved views allow you to easily jump to points of interest in the model. A saved view remembers the 
camera location and orientation along with the levels and models that have been set to display. 

 

Saved Views quick access dialog icons. This can be used to navigate between the cross sections from the 
sheet models. 

 Open Design Model 

 Open Drawing Model 

 Show Callouts (Not used at this time) 

 Open Sheet Model (Only visible from the Drawing and Design models) 

Manage Saved Views 

You can view all the Save Views of your cross sections within the 
design model where the cross sections were clipped from using 
the named boundaries tools. By clicking on the Manage Save 
Views (shown to the right). 

Note: Anytime you use the named boundaries tools to create 
sheets it will always generate a saved view of that named 
boundary. (This is a snapshot of how the view looks at them time of 
creating the named boundary). 

Within the Saved Views 
Manager dialog, you can 
select the saved view and 
update it from the Design-3D 
model view 1 if changes have 
been made after the cross 
sections named boundary has 
been created. 

You can also delete the saved 
views within this dialog.  
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Note: In the case of the deletion of the Named Boundaries graphic element you will need to open the Saved 
View Manager and manually delete the saved view for that Named Boundary. If the saved view isn’t deleted 
out of the Saved View Manager, you will run into issues when trying to recreate Named Boundaries.  

Drawing Model vs. Sheet Model Usage 
Each cross-section is displayed in a drawing model. The various drawing models are referenced to the 
sheets. Each sheet is contained in its own sheet model. The models are intended to be used as follows: 

Drawing Models 
All annotations placed in the cross-sections should be placed in the drawing model. The cross-
section grid area represents the clipping limits of the cross-section on the sheets; therefore, 
anything drawn outside of the grid will not be displayed on the cross-section sheets. 

Sheet Models 
The sheet model is intended to be used for printing. All annotation, other than the sheet border 
information, should be placed in the various drawing models. 

 

End Area Volume Report 

Quantities can be extracted from the 3D mesh elements (see Create Cut and Fill 3D Meshes) using a 
previously placed set of cross section named boundaries using the End Area Volume Report, shown 
below. When the command is process, the named boundaries are tagged with the end area quantity values, 
which can then be used for cross-section annotation. 
 

 
After selecting the command, choose the named boundary 
group that will be tagged with the quantity information. 

 
When prompted, select any named boundary group that you 
wish to exclude from the process. Right-click (reset) when 
complete. 
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After processing the End Area Volume Report is displayed as shown below. 

 
Each named boundary is tagged with the quantity information. 
By default, the End Area Volume Report shows cut and fill volumes in Cubic Feet. From the Civil Report 
Browser dialog, select Tools > Format Options to access the dialog shown below. 

 
 

 
 
For ODOT projects, 
toggle on the Convert 
to Cubic Yard option as 
shown at left. 
 
Select Close to apply 
the changes. Changes in 
format are applied to 
the current report 
values. 
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Various reports are available as shown on the previous page. It is good practice to save this report by 
choosing the File > Save As option. 
 
Another report you may want to consider saving is the Volumes report, shown below. This report shows 
the quantities for each component. 

 

Displaying End Area Quantities 
End area volumes are annotated in a table in the drawing model for each cross section as shown below. 

 

The table is placed as part of the cross-section annotation. The table uses ORD Civil Fields for the end area 
quantities. These fields are automatically updated using the current values assigned to the named 
boundary when the drawing model is opened. 

Notes: 

• The table is placed only if a 3D line string is encountered in the 3D model generated by a point 
named “PGL” or “EX_Table” in the template that was used to generate the corridor model. 



 
Ohio Department of Transportation 
Office of CADD and Mapping Services May, 2024 

 

802 Cross-Section Sheets 802-19 
 

• The Seeding quantities are not computed by ORD. These entries are included in the table for use to 
manually place seeding quantities in the table. 

Updating the End Area Quantities 
If changes are made to the model, the 3D mesh prismoidal cut and fill elements must be regenerated, and 
the end area volume report must be reprocessed. Take the following steps to update the quantities if 
changes are made to the model: 

1. Open the DGN file containing the 3D mesh prismoidal volume elements 
2. Delete the previously created prismoidal volume cut and fill elements  
3. Run the Home > Civil Analysis > Create Cut Fill Volumes command 
4. Open the cross-section container DGN file 
5. Run the Home > Civil Analysis > End Area Volume Report command 
6. Open each cross-section drawing model. The quantity fields are automatically synchronized with 

the earthwork quantity values that have been assigned to the named boundaries as each cross-
section drawing model is opened 

Processing Sheets from Previously Generated Named Boundaries 
If the named boundaries were generated without creating the sheets, as is the case when running the End 
Area Volume Report after generating the named boundaries, the sheets can be generated from the named 
boundaries with the following steps: 

1. From the Drawing Production tab, select the icon at the lower right of the Named Boundaries 
group as shown below. The Named Boundaries dialog is opened. 

 
2. In the Named Boundaries dialog, select the cross-section group from the list. Toggle the Show the 

Create Drawing Dialog option on as shown below. 
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3. Choose the Create Cross Section Drawing command. The Create Drawing dialog, previously 
described, is opened. Complete the Create Drawing dialog to generate the cross-section sheets. 

 

Adding Cross Sections at Specific Stations 

The initial cross section named boundary placement is defined by selecting an alignment and specifying an 
interval. Additional named boundaries for specific locations such as a driveway or a drainage structure can 
be inserted using the Civil Cross Section 2 Points option. 

Additional cross section locations may be defined prior to, or after generating the initial sheets. Each 
workflow is summarized below. 

Adding Named Boundary Locations Before Generating the Initial Sheets 
When the initial set of named boundaries is defined for the cross sections, be sure to toggle the Create 
Drawing option OFF. This allows the user the opportunity to define additional named boundaries at 
specific locations not covered by the initial named boundary interval placement. 

Take the following steps to define additional cross section named boundary locations: 

• From the OpenRoads Modeling WorkFlow, select Drawing Production > Named Boundary to 
initiate the process. The Place Named Boundary dialog is opened. 

• If multiple locations are to be defined, toggle the Create Drawing option OFF 
• Select the fifth icon, Civil Cross Section 2 Points to begin the process of placing the cross section 

named boundaries 
• Select the desired Drawing Seed for the cross section named boundaries. 
• Select the Group. The drop-down list will include any previously defined cross section groups. 
• Select the alignment for the named boundaries 
• After the alignment has been identified, enter data points for the start and end of the named 

boundary location. A third data point is required to accept the named boundary placement 
• To define additional named boundary locations, the path element (alignment) must be identified 

each time. Follow the prompts in the lower left corner of the MicroStation window. 

In the example below, a named boundary has been added at a driveway location. 
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Tip: For best results, create any additional named boundaries using Civil AccuDraw to define the 
station and offset values for the boundary. Use the same offset values as the primary cross-sections. 

• Toggle on the Create Drawing option ON prior to defining the last boundary to launch the Create 
Drawing dialog. 
 
If you forget to toggle this option back on, the Create Drawing dialog can be accessed from the 
Named Boundaries dialog. See Processing Sheets from Previously Generated Named Boundaries, 
for more information. 

Adding Named Boundary Locations to Previously Generated Sheets 
Occasionally it is necessary to add a cross-section location after the initial sheets have been generated. 
OpenRoads version 10.10 provides functionality to generate new sheet models while retaining previously 
generated cross-section drawing models. 

Before processing a new set of cross-section sheets, it is necessary to manually delete previously generated 
sheet models. Open the Models dialog from one of the OpenRoads WorkFlows by selecting the Models icon 
on the Home tab. Select the sheet models to be deleted, and then choose the Delete Model(s) icon like the 
example below. 
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1. From the Drawing Production tab, select the icon at the lower right of the Named Boundaries 
group as shown below. The Named Boundaries dialog is opened. 

 
2. In the Named Boundaries dialog, select the cross-section group from the list. Toggle the Show the 

Create Drawing Dialog option on as shown below. 

 

3. Right click on the named boundary group name and choose the Create Cross Sections from 
Drawings option. 
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4. The Create Sheets from Drawings dialog is opened as shown below.  

 

Select OK to initiate the process. 

 

 

 

 

 

 

 

 

 

 

It is also possible to create new sheets from specifically selected named boundaries as shown 
below. 
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Displaying Right-of-Way on Cross-Sections 

The location of both the existing and proposed the Right-of-Way lines can be displayed in a dynamic cross-
section view and on the cross-section sheets like the example shown below: 
 
To display the Right-of-Way lines on the cross-sections, each Right-of-Way line must have an existing 
profile defined. This is accomplished by opening a profile view for each Right-of-Way line and defining the 
exiting ground profile as the active profile. When the profile is defined for right-of-way lines, a 3D line 
string is created in the 3D model for the line. 
 
The workflow to assign a profile to the right-of-way lines is as follows: 
 

• In the right-of-way basemap design file (BR), attach the design file containing the existing terrain 
• Set the referenced terrain model as the active terrain by selecting the terrain and choosing the Set 

As Active Terrain Model option from the pop-up menu. 

 
• Open a profile model for each right-of-way line, either by selecting the element and choosing the 

Open Profile Model option, or by holding down the right-mouse button and choosing View 
Control > 2 Views Plan/Profile from the pop-up menu. 

• Select the ground line in the profile window and choose the Set As Active Profile option from the 
pop-up menu 
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A 3D element is generated in the 3D model like the example below. 
 

 
When cross sections are generated using the Named Boundary tool using the method provided on page 
802-9, the user will notice that the Right-of-Way cells aren’t present in the drawing models.  
 
Note: In the past the Right-of-Way Cells would have been placed automatically within the sheet clipping 
process.  

If the cross section intersects a 3D Right-of-Way line in the 3D model the user will still see a Right-of-Way  
Dot (3D Linear Element) placed along the existing terrain line. 
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If that is the case the user will need to follow these steps to show the Right-of-Way cells on all the cross 
sections.  

• With in a cross section drawing model make sure that the OpenRoads Modeling workflow then 
navigate to Drawing Production>Annotations. 

• Select the Drawing Model Annotation tool within the Annotate Drawing Model dialog and the 
user will have a few options. 

Annotate Drawing Model 

• All Drawing Model: If checked the process with apply 
the selected Annotation Group to all drawing models 
within the open dgn. 

• Annotation Group: Is a collection of annotation 
definitions. 
 

• In most cases the user should check on All Drawing Models so that the Annotation Group is 
applied to all the cross section drawing models within the dgn. 

• Next select the  within the Annotation Group preview and navigate through the folders Cross 
Section>Drawing then select R/W Annotation. 

• Finally, the user will need to Datapoint within the Drawing model view to activate the Drawing 
Model Annotation process. The user should now see the Right-of-Way cells like in the example 
below. 
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OpenRoads Software Version 

This document was prepared using the following software version: 

OpenRoads Designer CONNECT Edition – 2021 Release 1 Update 10 – Version 10.10.01.03 

This document was updated using the following software version: 

OpenRoads Designer CONNECT Edition – 2022 Release 3 Update 12 – Version 10.12.02.04 

 

Contacts 

For any questions, suggestions, or problems with this document please contact the ODOT Office of CADD 
and Mapping Services by use of the following form on the ODOT website: 

https://odot.formstack.com/forms/cadd_servicerequest 

 

 

https://odot.formstack.com/forms/cadd_servicerequest
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